Excel®
Introduction
COPYRIGHT

Copyright ©2002 by EZ-REF Courseware, Laguna Beach, CA  http://www.ezref.com/  All rights reserved. This publication, including the student manual, instructor's guide and exercise files, or any part thereof, may not be reproduced or transmitted in any form or by any means, electronic or mechanical, without prior written permission of EZ-REF Courseware.

TRADEMARKS

EZ-REF is a trademark of EZ-REF Courseware. All other products or brand names mentioned are trademarks or registered trademarks of their respective holders.

DISCLAIMER

While EZ-REF Courseware has taken care to ensure the accuracy and quality of these materials, all material is provided without any warranty whatsoever, including, but not limited to, the implied warranties of merchantability or fitness for a particular purpose. Any persons or businesses mentioned in the text of this manual are strictly fictitious. Any resemblances to existing or deceased persons, or existing or defunct businesses, is entirely coincidental.

Product Code:  MS EXCEL 2002-1  1.4
TABLE OF CONTENTS

WORKSHEET BASICS .......................................................................................................................... 5

RUNNING MICROSOFT EXCEL ........................................................................................................... 6

THE EXCEL SCREEN .............................................................................................................................. 7
  SHOWING/HIDING THE TASK PANES .................................................................................................. 10
  CHANGING THE ZOOM FACTOR ......................................................................................................... 11
  DISPLAYING ALL TOOLS ..................................................................................................................... 12

SMART TAGS ........................................................................................................................................... 13
  USING SMART TAGS IN WORKBOOKS ............................................................................................... 16

CREATING A NEW WORKBOOK .......................................................................................................... 17

CLOSING A WORKBOOK ..................................................................................................................... 18

OPENING AN EXISTING WORKBOOK ................................................................................................ 19

ENTERING INFORMATION .................................................................................................................... 22
  THE AUTOCOMPLETE FEATURE ........................................................................................................ 23
  PICK FROM LIST .................................................................................................................................. 23
  NUMBERS STORED AS TEXT ............................................................................................................... 24

USING THE AUTO FILL .......................................................................................................................... 25
  AUTO FILL OPTIONS ......................................................................................................................... 26

EDITING DATA ........................................................................................................................................ 27
  DELETING DATA .................................................................................................................................. 27
  OOPS! UNDOING THE DELETION ........................................................................................................ 27

WORKING WITH BLOCKS ...................................................................................................................... 28
  MOUSE SHAPES ................................................................................................................................... 29
  SELECTING A CONTIGUOUS BLOCK OF CELLS ............................................................................... 30
  SELECTING NONCONTIGUOUS BLOCKS OF CELLS .......................................................................... 30
  SELECTING THE ENTIRE WORKSHEET ............................................................................................. 30

APPLYING ATTRIBUTES ....................................................................................................................... 31

CHANGING FONTS & POINT SIZE ....................................................................................................... 32

ALIGNING CELL DATA .......................................................................................................................... 33
  CENTERING ACROSS COLUMNS ........................................................................................................... 33
  INDENTING TEXT WITHIN A CELL ..................................................................................................... 34

FORMATTING NUMBERS ..................................................................................................................... 34

CELL BORDERS AND COLORS ............................................................................................................. 35
  ADDING CELL BORDERS ..................................................................................................................... 35
  ADDING A FILL COLOR............................................................................................................................ 36
  CHANGING THE FONT COLOR ................................................................................................................ 37

ADJUSTING COLUMN WIDTH & ROW HEIGHT ...................................................................................... 38

SAVING YOUR WORKBOOK ................................................................................................................... 40

ENTERING A FORMULA .......................................................................................................................... 42
  ENTERING NATURAL LANGUAGE FORMULAS ................................................................................. 43
  CORRECTING FORMULAS ..................................................................................................................... 44

WORKING WITH BUILT-IN FUNCTIONS ............................................................................................. 45
  USING THE FORMULA PALETTE ......................................................................................................... 46
  THE AUTOSUM FEATURE ..................................................................................................................... 47

©2002 EZ-REF Courseware
WORKSHEET BASICS

The horizontal bar across the top of the worksheet is filled with letters, beginning with A and ending with the letter IV. Each letter represents a **column** while the vertical bar along the left side of the worksheet is filled with numbers that refer to **rows**. The rows are numbered 1 through 65536.

The intersection between a column and a row is referred to as a **cell**. A cell is similar to a box that can be used to store pieces of information. Each piece of information could be a word or group of words, a number or a mathematical formula.

Each cell has its own **address**. This address is used in formulas for referencing different parts of the worksheet. The address of a cell is defined by the letter of the column it is located in and the number of the row. For example, the address of a cell in column B, row 5 would be referred to as **B5**. The column is always listed first followed by the row without any spaces between the two.

These cell addresses are useful when entering formulas. Instead of typing actual values in your equations, you simply type the cell address that the value is stored in. Then, if you need to go back and change one of the values the worksheet automatically updates the answer based on the new number(s).

For example, instead of typing 67*5.4 you could enter C5*D5. The number 67 is stored in cell C5 and the number 5.4 is stored in cell D5. If these numbers change next month or next year, the formula remains correct as it references the cells - not the actual values. With the second formula, you can change the numbers stored in cells C5 and D5 as often as required and see the result recalculate immediately.
RUNNING MICROSOFT EXCEL

USAGE: MS Excel can be accessed directly through the desktop or through the Start menu (located on the taskbar at the bottom of the screen).

If you have a shortcut on your desktop, double-click on the Microsoft Excel icon to run the application.

Although the quickest way of running Excel is through the desktop (shown above), you can also access the Start menu (located along the far left side of the taskbar at the bottom of the desktop) which allows you to locate any program available on your system.

Follow the steps shown below to run Excel from the Start menu:

1. **Click** on this button (located on the far left side of the taskbar - at the bottom of the desktop) to access the Windows Start menu.

2. Select **Programs** from the pop-up menu.

3. Select **Microsoft Excel** from the Programs sub-menu.
THE EXCEL SCREEN

After you start the program, you are taken into a blank untitled workbook where you may begin entering your data. You will notice that the program window includes many of the standard elements common to most Windows applications as well as a few items that are unique to Excel. The screen can be quite intimidating the first time you see it as there are so many items displayed on it. However, if you take a few minutes to familiarize yourself with the various screen elements, the program will become easier to work with.

Across the top of the Excel window is the **Title Bar** which displays the name of the application. In the far left corner of the title bar is a small Excel icon (referred to as the “Control Icon”) which is used to access a pull-down menu containing selections for changing the window’s size and placement. In the upper right corner are the three standard Windows buttons for minimizing, maximizing/restoring the window, and closing the program.

The second line is referred to as the **Menu Bar** and contains all of the commands required to use this application. You can access any menu item by simply pointing to it and clicking the **[LEFT]** mouse button once. Notice that each menu item has one underlined letter which can be used in conjunction with the **Alt** key to access the menu directly through the keyboard. Once the menu is opened, you may notice icons to the left of some of the options. If a menu item could have been accessed via the tool bar, Excel displays these tool bar icons along the left side of the opened menu to help you associate the menu item with the correct icon.
Some menus provide additional options which are not immediately displayed. To access these extra options, you may either click on the button (located along the bottom of the pull-down menu) or double-click the menu.

To the right side of the menu bar is a help box where you may enter a quick question. Simply click in the Ask a Question box and type your question (such as “how do I print”) and press the key. Excel will run its help feature and display the help topics most closely associated with the question you entered.

In the far right corner of the menu bar line are the three standard Windows buttons for minimizing, maximizing/restoring the document window, and closing the current workbook. To quickly close the current workbook, click on the button.

The standard Tool Bar is located on the left side of the third line and can be used to quickly perform functions without having to access the menu. If you point to a tool without clicking the mouse button, a brief description of the tool will appear.

The Format Bar is combined with the tool bar and is placed along the right side of the third line. This bar offers a variety of shortcuts for changing the appearance of cells.

Because these two tool bars are combined, you cannot see all of the icons. Instead, Excel displays the most commonly used tools on these two bars and offers an additional button to access the hidden tools. Once you select a tool that was previously hidden, Excel displays it directly on the standard or formatting tool bar for future use. This allows you to personalize the tool bars to display the tools you most often use. In addition, some tool bars contain an extra button that can be used to add or remove tools.

The next line is the Formula Bar which displays the current cell address and its contents. As you move from cell to cell, Excel will keep track of the current cell address for you.

The next section of the screen lists the columns and rows within the current worksheet. As mentioned, columns are lettered and rows are numbered. The first 26 columns are lettered A through Z. Excel then begins lettering the 27th column with AA and so on. In a single Excel worksheet there are 256 columns (lettered A-IV) and 65,536 rows (numbered 1-65536).
The highlighted borders around the document window indicate the columns and rows and are used to identify where on the worksheet you are located since you obviously cannot see an entire worksheet of this size on the screen at one time.

The worksheet itself is located to the right and beneath the borders. This is where you will actually be working and entering information. The outlined cell (the one with the dark borders) within the worksheet is referred to as the active cell. Each cell may contain text, numbers or dates. You can enter up to 32,000 characters in each cell.

Towards the bottom of the worksheet is a small Tab that identifies each sheet within the workbook (file). If there are multiple sheets, you can use the tabs to easily identify what data is stored on each sheet. For example, the top sheet could be "Expenses" and the second sheet could be called "Income". When you begin a new workbook, the tabs default to being labeled Sheet1, Sheet2, etc.

Along the bottom of the screen is another bar called the Status Bar. This bar is used to display various information about the system and current workbook. The left corner of this line lists the Mode Indicator which tells you what mode you are currently working in. When Excel is ready for you to enter text, the mode indicator will read “Ready”.

A separate window is placed to the right of the worksheet area and is referred to as the Task Pane. This window is used to quickly access your most commonly used tasks (such as creating a new workbook or opening an existing file). There are other tasks that Excel will display within the task pane, depending on what you are currently working on. In addition, you can manually switch panes by selecting the one you wish to view from the pull-down list located at the top of the currently displayed task pane.

To make working with multiple workbooks less confusing, Excel has included a feature which automatically displays all opened workbooks along the taskbar. Rather than having to access the menu labeled Window to switch between opened files, you can simply use your mouse to click on the name of the file you wish to access directly on the taskbar. Once selected, that file becomes the active window.
CHANGING THE VIEW

USAGE: Excel allows you to customize the screen in a variety of ways.

SHOWING/HIDING THE TASK PANE

The right side of the workbook window contains the task pane which allows you to quickly perform common tasks (such as opening an existing file or creating a new workbook). To increase your work space, remove the task pane from view by clicking on the button (located in the upper right corner of the task pane).

NOTE: Once the task pane has been removed from view, you can easily redisplay it by accessing the View menu.

Depending on the task being performed, Excel offers a variety of panes. To switch to another, click on the down arrow to the right of the pane name and select another task pane to display.
CHANGING THE ZOOM FACTOR

The **Zoom** button (located on the tool bar at the top of the screen) allows you to change the size of the viewing area. This does not affect the actual printing of the file.

This can be helpful when working with a large workbook to get an overall view of the file (by zooming out) or to focus in on a specific section (by zooming in).

**NOTE:** If you have not used this tool before, it may not be displayed on the tool bar. To access it, click on the button and select it from the list of additional tools.

Click on the down arrow located to the right side of the current zoom factor. Scroll through the available zoom choices.

When you select a zoom factor, Excel will zoom in or out of the worksheet area - as specified in the Zoom.

You can also access the **View → Zoom** menu.

In addition, you can hide everything except the worksheet and the menu (which will increase your working area) by accessing the **View → Full Screen** menu.
DISPLAYING ALL TOOLS

Excel does not automatically display all of the tools on the tool bar and formatting bar. Instead, the most often-used tools are displayed while the other tools are hidden from view.

To view all of the tools, you can instruct Excel to display the tool bar and formatting bar on separate lines by following the two steps outlined below:

1. Click on this button (located to the right of the standard tool bar across the top of the screen).

2. Select **Show Buttons in Two Rows** from the options available.

Excel will display the standard tool bar on the third screen line and the formatting tool bar on the fourth line so that all tools are visible.

**NOTE:** To combine the two tool bars once again, simply click on the button (located to the far right of the tool bar and select **Show Buttons on One Row** from the pull-down list of options.
SMART TAGS

USAGE:

Excel is able to recognize a number of data types (such as e-mail addresses and stock ticker symbols) and provide a variety of options, depending on the type of data.

These data types will have a small symbol  attached to them, which are referred to as Smart Tags. For example, if Excel encounters an e-mail address within your workbook, the smart tag attached to the address would provide an option to add the address to your Outlook Contact list while a stock ticker symbol’s smart tag would offer the option of connecting to the Internet and viewing the stock’s latest value.

The smart tag symbol  is not visible unless you move your mouse pointer over the cell containing the data item. However, you can recognize that a cell contains a smart tag by the purple triangle (located in the lower right corner of the cell), as illustrated below:

Since there are various types of data that can be recognized, you will need to decide which items should be tagged. To do so, access the following menu:

MENU:

Tools
  Spelling...
  Error checking...
  Speeds
  Open Workbooks...
  Track Changes
  Compare and Merge Workbooks...
  Protection
  Offline Collaboration
  @Risk Setup...
  Suggested...
  Formulas Autotypes...
  Tools on the Web...
  More...
  Add-ins...
  AutoCorrect Options...
  Customize...
  Options...

Tools
AutoCorrect...
The following dialog box will be displayed:

Excel can recognize certain types of data in your workbooks. For each recognized type, there are actions you can perform with that data.

- **Label data with smart tags**

  **Recognizers:**
  - Smart tag lists (MSN MoneyCentral Financial Symbols)
  - Recent Outlook e-mail recipients

The dialog box contains the following options:

**Label data with smart tags**
Check this box to ensure Excel includes smart tag labels within your workbook.

**Recognizers**
Check the boxes within this section to specify which types of data should be recognized and labeled with smart tags. For example, you can choose to include financial symbols and recent Outlook e-mail recipients.
Click on this button to clear out any previously set tags and begin checking the workbook for all smart tags.

Click on this button to access the Internet and view a list of additional smart tags provided by Microsoft and third party developers.

Show smart tags as  Click on the down arrow beside this box to select the type of indicator you would like to have displayed. Your choices include none, a button only or an indicator along with a button.

Embed smart tags in this workbook  Check this box to have Excel save the smart tags with the workbook.

When done setting the smart tag options, click on OK.
USING SMART TAGS IN WORKBOOKS

Once smart tags have been enabled, any time Excel encounters an item it recognizes within your workbook, a Smart Tag will be attached to it.

When you see the Smart Tag symbol, point to it until you see the down arrow appear beside it. Once you see the down arrow, click on the smart tag symbol to display a pull-down list of options, as illustrated below:

```
Financial Symbol
Insert refreshable stock price...
Stock quote on MSN MoneyCentral
Company report on MSN MoneyCentral
Recent news on MSN MoneyCentral
Remove this Smart Tag
Smart Tag Options...
```

**NOTE:** The options will vary depending on the type of data.

If the item is an e-mail address, you will be able to add it to your Contacts list so that you can easily access it through Outlook.

If the tagged item includes a financial symbol (such as a stock ticker), Excel will offer options to get the latest stock price, give you a stock quote from the MSN Money Central website, offer a company report, and display a financial news page from MSN Money Central.

If you want to delete the tag from the workbook, choose **Remove this Smart Tag**.

Select **Smart Tag Options** to display the dialog box containing the Smart Tag settings. This is the same dialog box as accessed through the **Tools → AutoCorrect** menu.
CREATING A NEW WORKBOOK

USAGE: When you first access Excel you are automatically taken into a blank, untitled workbook where you may begin entering data. If, however, you are in the midst of working with one file and then decide to create another workbook, you will need to instruct Excel as to what type of new document you wish to create.

You can either create another blank workbook or base the new file on one of Excel’s built-in templates or from one of your existing files. A template is used to determine the basic structure of the workbook and can contain predefined settings, such as formulas, formatting, and macros.

To simply create a new blank workbook, click on the NEW tool (located on both the tool bar and within the task pane).
CLOSING A WORKBOOK

USAGE: Once you have completed a workbook you will usually want to close it so that you can work on something else. Although you can have multiple workbooks open at the same time, normally when you are done with a file it makes sense to close it. This keeps your work space clean and frees up memory.

Click on the Close button. Be sure to click on the lower close button or you will be closing the application.

If you prefer accessing the menu:

**File**

**Close**

If changes have not been saved, the following box appears:

![Warning Message]

If you click on Yes, Excel will save the file using the current filename. Click on No to close the file without saving it.

**TIP:** If you have multiple workbooks open and would like to close them all at once, hold the Shift key down while selecting the “File” menu and choose Close All.
OPENING AN EXISTING WORKBOOK

USAGE:
If you wish to work on an existing file, you must open it. Choosing to open a file will place the requested workbook in another window so that more than one file can be open at the same time. You can then switch between the opened workbooks using the taskbar across the bottom of your screen.

Click on the **Open** tool (located on both the standard tool bar and within the task pane).

If you prefer accessing the menu:

**File**
**Open...**

The following dialog box will be displayed:
Along the left side of the dialog box, Excel displays the **Places Bar** which includes the History, My Documents, Desktop, Favorites, and My Network Places. Depending on which version of Windows you are using, you may see “Web Folders” instead of “My Network Places”. These “places” can be used to quickly access specific types of documents or storage locations.

If you do not store your workbooks in one of these locations, you will need to switch to a different drive/folder by clicking on the down arrow beside the box labeled **Look in** (located across the top of the dialog box) and select the location you wish to display.

Across the top of the dialog box are a series of buttons, as described below:

- ![Previous](image) Click on this tool to display previously visited folders.
- ![Up](image) This tool moves up one folder level at a time.
- ![Search](image) Click on this tool to search the Web for a storage location.
- ![Delete](image) This button is used to delete an existing file.
- ![Folder](image) Use this tool to create a new folder.
- ![View](image) Click on the down arrow beside this button to select the type of view to use for displaying the workbooks. You can use this option to display additional details, properties or preview the files.
- ![Advanced Options](image) Use this tool to access a pull-down menu for advanced options (such as finding, deleting, renaming files and mapping network drives).
If you want to open a workbook that was originally created in another format (such as another worksheet application), click on the down arrow beside the box labeled **Files of type** and select the format from the list provided.

When done, double-click on the name of the file you wish to open or highlight the name and click on **Open** to open the file.

If you click on the down arrow beside the **Open** button, you can choose from a list of options (such as opening the file as read-only or in your Web browser).

**TIP:** To open more than one workbook at a time, select the first by clicking on its name once to highlight it. Next, hold the **Ctrl** key down as you click on each additional file to be opened. Once all required files are selected, click on **Open** to actually open them. Each file will be placed in its own window.

**TIP:** The shortcut key for opening files is **Ctrl+O**.

**TIP:** By default, Excel lists the last four files used at the very bottom of the **File** menu for you to quickly reopen a file you have recently been working on.

You can increase the number of files displayed in the **File** menu to a maximum of nine by accessing the **Tools → Options** menu and then selecting the tab labeled “General”.

©2002 EZ-REF Courseware
ENTERING INFORMATION

USAGE: Excel allows you to type in words, numbers or formulas.

Click in the cell you wish to store the data in and then simply type the word(s), number or formula.

If you make a mistake and want to start over, press Esc.

Notice as you type, the entry is displayed both in the cell and in the formula bar. A thin, blinking cursor appears to the right of the entry and moves as you type.

If you make a mistake while typing, use the Backspace or Delete key to correct what has already been entered.

You cannot use the arrow keys at this time to make corrections! Pressing an arrow key will enter what you have typed so far into the cell and then automatically move the pointer in the direction of the arrow key you pressed.

Two symbols in little boxes also pop up to the left of the formula bar. The ✓ can be used by mouse users instead of pressing the Enter key. The X is used like the Esc key to cancel.

When entering text, words are automatically left aligned within the cell while numbers are placed to the right.

While entering columns of numbers, the column heading may not align correctly with the values. If text is wider than the cell it is stored in, it will appear to "spill" into the adjacent cell(s), providing they are empty.
THE AUTOCOMPLETE FEATURE

To save you from typing the same entry more than once, Excel offers a feature referred to as AutoComplete.

This feature tries to predict (based on your previous entries), what word you are currently entering. For example, if you have entered the word East in one or more cells in the current column/row, the next time you begin a cell entry with the letter E, Excel will fill the cell with the word East.

To accept this entry, simply press Enter.

Naturally, Excel is not always correct so if the prediction is wrong, simply continue typing.

PICK FROM LIST

If you have a large column of repeated entries, instead of continuously having to type the entries in yourself, you can select them from a list that Excel automatically generates from the current column entries.

Move to the cell where you want the entry placed. Click the [RIGHT] mouse button once.

From the pop-up menu that appears, select Pick from List....
From the list provided, select the entry you would like placed in the current cell.

NOTE: For this feature to work, you must select a cell directly beneath the current list of entries. If a blank cell exists between the current entries and your selected cell, the list will be empty.

NUMBERS STORED AS TEXT

As mentioned, the first character you enter determines the data type of the cell. If you begin with a number, Excel assumes you are entering a value, whereas if the first character is a letter, Excel stores the entry as a label.

However, if a number has inadvertently been entered as a label, Excel will display a small green triangle in the upper left corner of the cell - indicating there is a problem.

Click on the cell and a small warning icon will appear. Click on the icon to access the following pull-down menu:

You will have several options to choose from.

Select the Convert to Number option if the cell data is supposed to be stored as a value.

Select Ignore Error to remove the warning for this cell.
USING THE AUTO FILL

USAGE:
Excel offers a quick way to fill formulas from one cell to many within the worksheet. This command instructs Excel to copy cells from one row/column in a selection to adjacent cells of the selection.

Although you could access the Edit → Fill → Series... menu, the mouse is much quicker, as shown below:

1. Place your mouse over the small square in the lower right corner of the cell containing the formula you wish to copy. The pointer should change to a thin cross-hair.

2. Click the [LEFT] mouse button and drag so that all destination cells are selected. When the mouse is released, the formula will be "filled" in all cells.

This also works for text and numbers without formulas, such as months (shown in the example above) or actual numbers.

Excel's auto fill feature will fill a block of cells with either numbers or text depending on what is located in the first cell. For example, if the first cell contains the word "Jan", Excel will automatically fill the other cells with the rest of the months.

As you begin filling the destination cells with months, Excel will display the name of each month as it is being filled so that you know how far to fill.

TIP: 
To quickly fill the current cell with the contents of the cell above it, press Ctrl+D (to fill downward).

To fill the current cell with the contents of the cell to the left of it, press Ctrl+R (to fill right).
When working with numbers, however, you must enter two cells of data so that Excel knows what increments the numbers should be increased by each time. If you only enter a single number and then try to create a fill based on that single cell, Excel will simply copy the number down the worksheet.

To fill cells with a series of numbers, follow these steps:

1. Select the two cells containing the numbers. Once the two cells have been selected, release the mouse button.

2. Move the mouse to the bottom right corner of the second cell. The pointer should change to a thin cross-hair.

3. Click & drag the mouse to fill the other cells.

AUTO FILL OPTIONS

Once you have used the auto fill feature, a small icon will be placed in the bottom right corner of the last filled cell.

A list of auto fill options will be displayed. The default option is **Copy Cells** which instructs Excel to copy the data and formatting from the original cell to the destination cells.

The **Fill Formatting Only** option is used to copy the format from the original cell to the destination cells. This does not copy the data from the original cell.

Select **Fill Without Formatting** to copy the data from the original cell to the destination cells without changing the existing format.

**NOTE:** These auto fill options will vary depending on what you have just filled (e.g., a formula, a number, a month).
EDITING DATA

USAGE:

If you type something in a cell and then decide later to change or correct it, place your pointer on the cell to edit and reactivate it by selecting from one of the two methods mentioned below:

**Double-Click** on the cell you wish to edit

Your cursor will appear within the cell and you will be able to make corrections. Since you are automatically in the insert mode, pressing `-` will place you in typeover mode (**OVR**). Notice the status line indicates that typeover is on.

When done editing the cell, press **Enter**.

DELETING DATA

USAGE:

Although you can type over existing data - simply replacing it with the new information, there may be times when you would like to clear a cell out so that nothing is stored in it. In those instances it would make sense to delete the contents of the selected cell(s).

To delete the contents of a cell, move to the cell and press the **Delete** key once.

OOPS! UNDOING THE DELETION

Excel has the capability of remembering the last several actions performed and allows you to change your mind about most changes you have made.

Click on this tool to undo the last action.

If you click on the down arrow (to the right of the tool), you can scroll through the last several actions.

Move your mouse down the list to highlight the number of actions to undo. They must be done in sequence!
WORKING WITH BLOCKS

USAGE: Many commands and operations require that you work on more than one cell at a time. While you may not require the entire worksheet, you may need to work on a Block of cells.

A block includes any group of cells in a rectangular format, as shown in the illustration below.

Every block of cells has a beginning and ending address. The beginning address is the address of the cell in the top-left corner of the block whereas the ending address is the cell in the lower-right.

Normally, in the English language we use a dash to indicate a block of numbers, as in pages 5-20. Excel, however, requires that you use the colon between the beginning and ending addresses. Remember that the dash represents subtraction in worksheet programs. For example, the block C3:E14 refers to cells C3 through E14.

There are many commands (e.g., deleting, copying, formatting) that require the use of blocks.
MOUSE SHAPES

When working with Excel, it is very important to keep an eye on the mouse pointer as it changes shape depending on its current function, as discussed below:

If the mouse is in the shape of a thick cross, it can be used to select a single cell or block of cells for editing purposes.

The mouse changes to the thick cross when placed in the middle of a cell. Dragging the pointer when it is this shape simply highlights cells.

If the mouse is in the shape of a diagonal arrow, you can move the contents of the currently selected block of cells to another location within the worksheet.

The mouse changes to a pointer only when the tip of the arrow points to one of the outer borders of the cell block. Dragging the pointer when it is in this shape actually picks up the contents of the cell(s) and moves them to another location.

If the mouse is in the shape of a thin cross-hair, you can fill a formula or other information into adjacent cells within the worksheet.

The mouse pointer changes to a thin cross-hair only when the tip of the arrow is placed in the small square located in the bottom right-corner of a cell. Dragging the pointer when it is in this shape fills data.
SELECTING A BLOCK OF CELLS

Place the mouse in the middle of the first cell. The pointer's shape should be a thick cross-hair. Click and drag to highlight.

To select an entire column or row, click on the letter of the column or the number of the row.

Hold the *Shift* key down and press the arrows to select a block.

SELECTING A CONTIGUOUS BLOCK OF CELLS

1. Click in the first cell of the block to be highlighted.
2. Move to the last cell (do *not* click the *[LEFT]* mouse button).
3. In the last cell, hold the *Shift* key down and click the *[LEFT]* mouse button once.

SELECTING NONCONTIGUOUS BLOCKS OF CELLS

1. Click on the first cell.
2. Move to each cell or group of cells to be selected and hold *Ctrl* down while you click the *[LEFT]* mouse button.

SELECTING THE ENTIRE WORKSHEET

To select the entire worksheet with a single click of the mouse button, point to the blank square - just above the first row indicator and to the left of the first column indicator and click the *[LEFT]* mouse button once. The entire worksheet will be highlighted.
APPLYING ATTRIBUTES

USAGE: To emphasize headings within your worksheet you may use the bold, underline, or italics attributes within Excel. Each attribute is activated/deactivated using the same steps. The first time you select the tool, the attribute is turned on. The second time it is turned off.

Begin by selecting the cell or block of cells to be modified.

Once the cells have been selected, you can use either the mouse or the keyboard to apply the attributes.

This tool (located on the formatting tool bar) toggles bold on/off.

This tool (located on the formatting tool bar) toggles italics on/off.

This tool (located on the formatting tool bar) toggles underline on/off.
CHANGING FONTS & POINT SIZE

USAGE:

To make your workbook appear more interesting, you may want to change the font or apply different font sizes to titles or headings.

To change the font of a cell or block of selected cells, follow the steps outlined below:

1. Select the cell(s) to be changed.

2. Click on the down arrow beside the Font tool (which is located on the formatting tool bar).

Notice that Excel displays a preview of each font directly within the list, as illustrated below:

3. Select the desired font from the pull-down list.

CHANGING THE FONT SIZE

You can also easily change the size of the font that is applied to a cell or block of cells.

To change the font size, follow the steps outlined below:

1. Select the cell(s) to be changed.

2. Click on the down arrow beside the Font Size button (which is located on the formatting tool bar).
ALIGNING CELL DATA

USAGE: Unless you specify otherwise, Excel left-justifies text and right-justifies numbers. That is, text fills cell space from left to right while numbers are filled from right to left so that they align properly.

To change the cell alignment for a single cell or a group of selected cells, click one of the following tools:

- Left Justified
- Centered
- Right Justified

CENTERING ACROSS COLUMNS

You can also center a heading across multiple columns. For example, if you have a title in cell A1 and you would like it centered across several adjacent columns (they must be blank), you can have Excel automatically center it.

1. Select both the cell containing the data and the empty adjacent cells in which you wish to center the information across. Once selected, release the mouse button.

2. Click on the tool once. If you select this tool a second time, Excel will remove the centering.

NOTE: If you do not see this tool, click on (located along the right side of the formatting tool bar) and then select it from the list of additional formatting tools.

NOTE: Even though the data appears to have moved to another cell, to edit the contents of the cell or apply attributes you must select the original cell.
INDENTING TEXT WITHIN A CELL

You can indent text within a cell. This can help when creating lists or outlines.

After selecting the cell(s) to be indented/oudented, click on one of the two tools shown below:

![Indent button](image)

Click on this button to **indent** the current cell text.

![Outdent button](image)

Click on this tool to **outdent** the current cell text.

Each time you click on one of these tools, Excel indents/outdents the cell(s) one more level.

**NOTE:**

If you have not used this tool before, it may not be displayed on the tool bar.

To access it, click on the button (located along the right side of the formatting tool bar) and then select the tool from the list of additional formatting tools.

FORMATTING NUMBERS

**USAGE:**

When entering values, Excel automatically uses a format which omits dollar signs, commas and a fixed number of decimal places. This can make numbers difficult to read at times and inconsistent. Excel does, however, allow you to access other built-in formats (such as percentage signs, dollar signs, etc.).

Select the cells to format and then choose on the following tools:

![Currency symbol](image)

Formats the current selection for **currency** with a dollar sign, a comma as a thousand separator and 2 decimal places. Example: **$45.00**
Formats the current selection for **percentage** by multiplying the numbers by 100 and adds the percent sign to the end with 0 decimal places. Example: **45%**

Formats the selection for **comma** by adding a comma as a thousand separator and two decimal places. Example: **4,500.00**

Increases the number of decimal places displayed. Each time this button is selected another decimal place is added to the selection.

Decreases the number of decimal places displayed. Each time this button is selected another decimal place is removed from the selection.

**CELL BORDERS AND COLORS**

**USAGE:** Excel also allows you to add borders to your cell entries. Lines and boxes provide useful visual emphasis for important information in a worksheet. With borders, you can create custom forms.

**ADDING CELL BORDERS**

1. Select the cell(s) to apply the border to.

2. Click on the down arrow beside the **Borders** tool (located on the formatting tool bar).

3. From the pull-down list, choose the type of border to be applied to the selected block of cells.

If you choose the last option (labeled **Draw Borders**), you can manually draw and erase borders using the Excel drawing tools.
TIP: Notice the shaded bar (across the top of the pull-down list). This is referred to as a “move handle” and can be used to drag the list to a new screen location. Once moved, this list becomes a floating tool bar. This option is available with most pull-down lists.

NOTE: If you have not used this tool before, it may not be displayed on the tool bar. To access it, click on the button (located along the right side of the formatting tool bar) and then select the tool from the list of additional formatting tools.

ADDING A FILL COLOR

Excel also allows you to add a shade color to the selected cell(s) when working with color displays or printouts.

1. Select the cell(s) to fill.

2. Click on the down arrow to the right of the Fill Color tool (which is located on the formatting tool bar). Excel will display a palette of available colors from which to choose.

   Notice that the first choice is used to remove existing colors from the selected cell(s) and return to the default setting.

3. From the pull-down list, choose the fill color to be applied to the selected block of cells.

NOTE: If you have not used the Fill Color tool before, it may not be displayed on the formatting tool bar.
CHANGING THE FONT COLOR

Although Excel defaults to printing your text in black, you can quickly change the color of the font by accessing the tool bar, as outlined in the steps shown below:

1. Select the cell(s) to modify.

2. Click on the down arrow beside the **Font Color** tool (which is located on the formatting tool bar).

3. Select the color you wish to use (from the pull-down list) for the selected text.

---

**NOTE:** If you have not used the **Font Color** tool before, it may not be displayed on the tool bar.

To access it, click on the button (located along the right side of the formatting tool bar) and then select the tool from the list of additional formatting tools.
ADJUSTING COLUMN WIDTH & ROW HEIGHT

USAGE:

Sometimes cell entries are too long to fit into the standard width columns. Text will appear to "spill" over into adjacent cells as long as those cells are empty. If the adjacent cells are not empty, Excel will truncate the text.

When entering large numbers, however, Excel will display the number in scientific notation if the column is not wide enough to display the entire number. You may also see a large number (resulting from a formula) displayed as ###### - indicating that the column is not wide enough to display the answer contained within the cell. However, if you apply formatting (such as dollar signs), Excel will automatically adjust the column to fit the largest entry so that the number remains visible.

Should a cell be too narrow for text or numbers that you have entered, you can widen the column in which the entry is located by following the steps outlined below:

1. Place the mouse pointer in the column heading area to the right of the lettered column to adjust. Make sure the mouse pointer is on the column margin line. The pointer changes to a cross-hair indicating you are on the margin line.

2. Click and drag the column margin line either to the right (expanding it) or to the left (shrinking it).

In the example above, column F is being stretched to the right. Notice the "cross-hair".

NOTE: To change the height of a row, place the mouse pointer on the bottom line of the row number (located on the left side of the worksheet). A thin cross-hair will appear. When you see the thin cross-hair, drag the mouse up/down to adjust the row’s height.
**TIP:** If you double-click the column or row margin line, Excel will automatically adjust the width of the column or row to fit the largest cell in the column/row.

**NOTE:** You may also change the width of multiple columns or rows at once, by selecting the columns or rows (by clicking and dragging the mouse over each of the column letters or row numbers) before adjusting their width/height.

For this option to work.
SAVING YOUR WORKBOOK

USAGE:

After having created a worksheet, you will want to save it using a name that will allow you to easily find it again. There are two menu options when saving a workbook: SAVE and SAVE AS.

SAVE is the normal save feature which will ask you the first time you save a file to assign a name to it. From that point on, choosing SAVE will simply update the file to include the latest changes. On the other hand, SAVE AS saves an existing file under a new name or as a different format to be imported into another program.

Click on the Save tool.

If you prefer accessing the menu:

MENU:

file
Save

The first time you save a workbook file, Excel provides a dialog box prompting you to enter a file name, as shown below:

Letters, numbers and spaces are allowed. Enter 1-255 characters.
Along the left side of the dialog box, Excel displays the **Places Bar** which includes the History, My Documents, Desktop, Favorites, and My Network Places. Depending on which version of Windows you are using, you may see “Web Folders” instead of “My Network Places”. These “places” can be used to quickly access specific types of files or storage locations. If you do not want to store your workbook in one of these locations, you will need to save it in a different folder by clicking on the down arrow beside the box labeled **Save in** (located across the top of the dialog box) and select a new storage location.

Across the top of the dialog box are a series of buttons, as described below:

- Click on this tool to display previously visited folders.
- This tool moves up one folder level at a time.
- Click on this tool to search the Web for a storage location.
- This button is used to delete an existing file.
- Use this tool to create a new folder.
- Click on the down arrow beside this button to select the type of view for displaying the files.
- Use this tool to access a pull-down menu for advanced saving options (such as mapping network drives and customizing the Web options).

To save the file in another format (such as another worksheet program or a previous version of Excel so that someone else can edit the file who has not yet upgraded to this version), click on the down arrow beside the box labeled **Save as type** and select the format from the list.

Enter a name for the file in the box provided and then click on **Save** to actually save the workbook.

**TIP:** The shortcut key for saving is **Ctrl+S**.
ENTERING A FORMULA

USAGE: Formulas are used to obtain answers based on mathematical equations that you design. Formulas can be as simple as "2+2" or as complex as calculating the depreciation of fixed assets. When creating formulas, you may use actual values, cell addresses or a combination of the two.

1 The equal sign (=) is used to indicate to Excel that you are about to enter a formula. This also ensures that formulas beginning with a cell address are not mistaken for text.

2 Next, you must enter the actual formula for Excel to calculate. When entering these formulas, the following basic mathematical operators are used:

+ (add) - (subtract) * (multiply) / (divide)

3 When a formula is complete and the Enter key has been pressed, the result will be displayed in the current cell. The formula itself is displayed in the formula bar (located in the upper-left of the screen next to the cell address).

NOTE: In order to view a formula, you must select the cell in which it is stored.

TIP: If you select a group of cells and look at the status bar (at bottom of the screen), Excel will display the total (sum) of the selected cells.
ENTERING NATURAL LANGUAGE FORMULAS

Excel has the ability to understand and translate natural language formulas. This means that you can type in a formula using the names associated with the data instead of trying to remember the actual cell addresses. This can be extremely helpful for new users who have not worked with other worksheet applications.

It is important, however, to understand how Excel associates the labels with the numbers. Using the example shown below, FY 1998 and FY 1999 refer to the columns of values stored beneath them while 1st qtr refers to the values placed in cells B2 and B3.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>FY 1990</td>
<td>FY 1999</td>
<td>Totals</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1st qtr</td>
<td>$30,000</td>
<td>$50,000</td>
<td>$30,000</td>
</tr>
<tr>
<td>3</td>
<td>2nd qtr</td>
<td>$45,965</td>
<td>$65,000</td>
<td>$110,965</td>
</tr>
<tr>
<td>4</td>
<td>3rd qtr</td>
<td>$51,355</td>
<td>$75,000</td>
<td>$126,355</td>
</tr>
<tr>
<td>5</td>
<td>4th qtr</td>
<td>$56,450</td>
<td>$56,450</td>
<td>$112,900</td>
</tr>
<tr>
<td>6</td>
<td>Total</td>
<td>$163,770</td>
<td>$246,450</td>
<td>$430,220</td>
</tr>
</tbody>
</table>

To create a formula that calculates the total for the 1st quarter, you would move to cell D2 and enter either of the following formulas:

$$=B2+C2$$
$$=FY\ 1998+FY\ 1999$$

The second formula (shown above) takes advantage of Excel's natural language feature. (Notice the space between FY and 1998. Without this space, Excel would read the formula as referring to cell FY1998 in the current worksheet.)

**NOTE:** For the formula to work, access the Tools ➔ Options menu and select the Calculation tab and check the box labeled Accept labels in formulas.

To create a total for FY 1998, you would move to cell B6 and enter either of the following formulas:

$$=B2+B3+B4+B5$$
$$=1st\ qtr+2nd\ qtr+3rd\ qtr+4th\ qtr$$

The second formula uses Excel's natural language feature.
CORRECTING FORMULAS

Excel can help to locate errors by checking your formulas for common mistakes and offering a suggested correction.

When you press the Enter key after typing in a formula, Excel checks the formula for possible syntax errors.

If an error is encountered, a dialog box will pop-up explaining what Excel thinks is the problem with the formula and asking if it should correct the formula based on its suggestion.

Select **Yes** to have Excel change the formula based on its suggestion.

Click on **No** to cancel this box and correct the error yourself.

**NOTE:** If you enter one of the natural language formulas (discussed on the previous page) and include a label with spaces (e.g., 1st Qtr), Excel will display an error message and suggest that quotes be added to the labels in the formula.
WORKING WITH BUILT-IN FUNCTIONS

Usage:

General mathematical built-in functions are provided with Excel to carry out calculations on data within the worksheet and can take the place of certain types of formulas.

Functions begin with the = sign just as formulas do. For example, if you had a large column of numbers to be added (A1:A100), you might think you need a long formula to include all of the addresses (=A1+A2+A3....+A99+A100). However, Excel provides a mathematical function which is used primarily to add blocks of numbers. The formula could be re-written as =SUM(A1:A100) which is much shorter.

To calculate the sum of a block of numbers, move to the cell where the answer is to be placed and use this built-in function:

=SUM(FIRST CELL:LAST CELL)

You must define the block just like any other block by specifying the first and last cell addresses.

To calculate the average value for a block of cells:

=AVERAGE(FIRST CELL:LAST CELL)

To return the largest value in a block of cells:

=MAX(FIRST CELL: LAST CELL)

To return the smallest value in a block of cells:

=MIN(FIRST CELL:LAST CELL)

To count the number of numeric entries in a block of cells:

=COUNT(FIRST CELL:LAST CELL)
USING THE FORMULA PALETTE

If you would like some guidance, Excel can list the most common functions and then prompt you for the various arguments required by displaying the Formula Palette.

As soon as you type the ™ sign in a cell, this button will be listed along the left side of the Formula Bar.

The last function you chose will be displayed on the button. If you simply click on the button that function will be selected.

To choose a different function, click on the down arrow ▼ to the right of the button and then select a new function from the list.

Once the function has been selected, Excel will display the Formula Palette, as shown below:

The palette will display a description of the currently selected function and list the arguments required for the function.

The next required argument will be displayed in bold. This helps guide you through each step properly.

Notice as you begin entering the arguments, the palette displays the current result.

When you are done, click on OK to actually enter the function and close the palette.
THE AUTOSUM FEATURE

Excel can make somewhat of an intelligent decision on its own and determine which cells of a row or column should be "summed". This is called the **Autosum** feature.

To use the AutoSum feature, follow the steps outlined below:

1. **Select the cell to the right or below the cells to be totaled.**
2. **Double-Click** on this tool (which is located on the standard tool bar).

**NOTE:** If you click on the AutoSum tool once, Excel will highlight the cells it assumes you want to include in the formula. The second click is used to confirm the selection.

If, by chance, Excel has selected the wrong group of cells, you can highlight the correct block before clicking on the tool a second time.
ACCESSING OTHER FUNCTIONS

In addition to adding a column or row, the AutoSum tool can also be used to perform a variety of other built-in functions.

To access one of the other available functions, follow the steps outlined below:

1. Select the cell where you want the function to be stored.
2. Click on the down arrow beside this tool.
3. Excel will provide a pull-down list of the most commonly used functions. Select the function you want to use from the list provided.
4. If you look in the current cell, you will see that Excel has placed the selected function in the cell.

You will need to confirm that this is correct by clicking on the autosum tool a second time to accept the function.

NOTE: If, by chance, Excel has selected the wrong group of cells, you can highlight the correct block before clicking on the tool a second time.
To have Excel perform a function that is not displayed in the pull-down list, you will need to access the **Insert Function** dialog box, as outlined in the steps below:

1. Be sure that the current cell is the one in which you want the function to be placed.

2. Click on the down arrow beside the **AutoSum** tool (which is located on the standard tool bar).

3. Excel will provide a pull-down list of the most commonly used functions.
   - Select **More Functions...** from the list provided.

   The following dialog box will be displayed:

   ![Insert Function Dialog Box](image)

   - **Search for a function:**
     - Find the largest number
     - Or select a category: **Recommended**

   - **Select a function:**
     - **MAX**
     - **DMAX**

   - **MAX(number1,[number2,...])**
     - Returns the largest value in a set of values. Ignores logical values and text.
4 The dialog box is divided into two main sections. The top section of the box allows you to either enter an explanation as to the type of function you want to perform or select the category of function you are searching for. After entering the explanation or selecting the category, click on Go to view a list of related functions.

The bottom of the dialog box lists the results of your search.

Select the function you wish to use and click on OK.

5 You will be taken to a second dialog box where you will enter the block of cells to apply the function to, as shown below:

```
=MAX
Number1 B3:C3 = {8500,0}
Number2 = number

= 8500
```

Returns the largest value in a set of values. Ignores logical values and text.

**Number1**: number1,number2,… are 1 to 30 numbers, empty cells, logical values, or text numbers for which you want the maximum.

Formula result = $8,500.00

6 Type the block of cells in the box provided or click back in the worksheet to highlight the desired cells.

If you click on the button (within in the “Insert Function” dialog box), the dialog box will be temporarily set aside and you will be returned to the worksheet where you can use the mouse to select the block for the function.
A bar will be displayed while you select the block of cells to include in the formula, as illustrated below:

![E5:E18](image)

Once you have selected or entered the block of cells to use for the function, re-activate the "Insert Function" dialog box by clicking on the button (located in the upper right corner of the bar).

7 When done, choose OK or press the Enter key.
MOVING DATA

USAGE: If you have created a workbook and then decide that a portion of the data should be placed in a different area within the file or to a different file completely, you can move the contents by cutting and pasting. When you choose to cut a cell or block of cells, Excel removes the cell(s) from the current workbook and places it in the Windows Clipboard.

Although you could access the Edit → Cut and then the Edit → Paste menu, the steps shown below allow you to quickly move a cell or block of cells using the mouse:

1. Select the cell(s) to be moved.
2. Click on the Cut tool (located on the tool bar).
3. Notice that a marquee surrounds the cut cell(s). Move to the new location.
4. Click on the Paste tool (located on the tool bar). The data has now been moved to the new location.

NOTE: If you have not used these tools, they may not be displayed on the tool bar. To access one, click on the button and select it from the list of additional tools.
COPYING DATA

USAGE: If you need a portion of data duplicated within the same file or placed in another workbook within Excel, you can copy the data. This leaves the information in its original location while placing a copy of it in the new location. In this case, you would want to copy the data - in other words, leave it in the original location but take a copy of it to another location within the current workbook or to another file.

Although you could access the Edit \(\rightarrow\) Copy and then the Edit \(\rightarrow\) Paste menu, the steps shown below allow you to quickly copy a block of cells using the mouse:

1. Select the cell(s) to be copied.

2. Click on the COPY tool (located on the tool bar). The block of cells are temporarily copied to the clipboard. Notice a marquee has been placed around the selected cells.

3. Move to the new location.

4. Click on the PASTE tool (located on the tool bar).

NOTE: If you have not used these tools, they may not be displayed on the tool bar. To access one, click on the button and select it from the list of additional tools.

NOTE: Notice that Excel displays a message on the status line allowing you to select the destination cell address and simply press E rather than having to paste.
PASTE OPTIONS

Once an item has been pasted, a small clipboard icon is displayed at that location within the worksheet. When you point to the icon, an arrow appears (indicating a pull-down list is available).

Click on this icon to select from a list of options that defines how the item should be pasted. These options depend on the type of content you are pasting, the application you are pasting from and the format of the data where you are pasting.

When you click on the clipboard icon from within your workbook, a pull-down list appears offering several formatting options.

Choose from one of the following options:

1. **Keep Source Formatting**
   - Select this option to retain the original format of the pasted item.

2. **Match Destination Formatting**
   - Choose this option to reformat the pasted item to match the format of the new location.
DRAGGING & DROPPING

USAGE: Excel also allows you to cut/copy and paste data within a worksheet by using the Drag & Drop feature available in most Windows programs. This feature allows mouse users to "drag" the selected block to a new location. Once the location is reached, you simply "drop" the selected cells off.

MOVING CELLS WITH DRAG & DROP

To drag and drop a cell or block of cells, follow the steps below:

1. Select the cell(s) to be moved.

2. Place the mouse pointer on one of the outer borders of the selected block.

   The pointer should change to a 4-way arrow.

3. Begin dragging the block. An outline of the cells moves with you. Notice as you drag that Excel displays the current cell address so you are sure where you are dragging, as shown in the illustration below:

4. When you reach the correct location, release the mouse button. The selection should have now been moved to the new location.
COPYING CELLS WITH DRAG & DROP

To copy cells using drag and drop, follow the steps shown below:

1. Select the cell(s) to be copied.

2. Place the mouse pointer on one of the outer borders of the selected block.

   The mouse pointer should change to a 4-way arrow.

3. Hold the **C** key down as you drag the block. An outline of the cells moves with you and the mouse pointer now has a plus sign (+) attached to it. Notice as you drag the block that Excel displays the current cell address so you are sure where you are dragging, as shown in the illustration below:

4. When you reach the desired location, release the mouse button. The selected block should now have been copied to the new location.
WORKING WITH THE OFFICE CLIPBOARD

USAGE:

You can use the Office Clipboard to collect multiple items to be pasted within Excel or other Office applications. The standard Windows clipboard is only able to store one item at a time. You have to paste whatever you have cut or copied before your next cut/copy can be completed.

However, the Office Clipboard can store up to 24 items at a time, making it easy to collect multiple items to be pasted. If you copy a 25th item, the first item in your clipboard will automatically be removed to make room for the latest entry.

**NOTE:** The number of items the clipboard can store depends on the amount of memory installed in your computer. If you have less than 64 MB, the clipboard can store up to 4 MB of data. If you have more than 64 MB of memory, the clipboard can store up to 8 MB.

The Office Clipboard is automatically activated and placed within the task pane of your workbook window when you cut or copy an item and then cut or copy a second one without first pasting the original one.

To copy multiple items to the Office Clipboard, follow the steps outlined below:

1. Select the cell(s) to be copied.
2. Click on this tool (located on the standard tool bar) to copy the selected item.
3. Select the next cell(s) to be copied and then click on this tool a second time.
The Office Clipboard will automatically be opened and displayed within the task pane, as shown below:

![Clipboard screenshot](image)

To display this task pane again, click Office Clipboard on the Edit menu or press Ctrl+C twice.

The clipboard will display each of the cut or copied items - with the latest item placed at the top of the list. If you have cut or copied several entries, a scroll bar will be placed along the right side so that you can quickly move through the items.

A small icon is placed to the left of each object to indicate what application the cut or copied item was originally created in.

4. Move to the location to which the item(s) should be pasted.
5. Click on the clipboard item to be pasted.
There are two tools available across the top of the clipboard:

- **Paste All**
  Click on this tool to paste each of the items stored within the Office Clipboard in the current workbook (or within the current Office application).

- **Clear All**
  Click on this button to clear the contents of the Office Clipboard. It will also clear the Windows Clipboard.

To remove a single item from the clipboard, point to the item you wish to remove until you see a small down arrow ▾.

- **Paste**
  Click on the down arrow ▾ and select **delete** from the list of options.

**CLIPBOARD OPTIONS**

Towards the bottom of the clipboard is a button **Options** which is used to change the display settings for the Office Clipboard.

- **Show Office Clipboard Automatically**
- **Collect Without Showing Office Clipboard**
- **Show Office Clipboard Icon on Taskbar**
- **Show Status Near Taskbar When Copying**

From the four options available, check the box labeled **Show Office Clipboard Automatically** to open the clipboard within the task pane when two items in a row have been copied.

Choose **Collect Without Showing Office Clipboard** if you prefer not to display the clipboard within the task pane when two items in a row have been copied. This option displays the clipboard icon on the taskbar even if you are in a different application.

Select **Show Office Clipboard Icon on Taskbar** to always display the clipboard icon at the bottom of your screen.
Choose **Show Status Near Taskbar When Copying** to display the status of a copied item on the taskbar.

Check each of the options you would like to enable from the list. Click a second time to disable the option.

Once the Office Clipboard has been activated, an icon will be placed in the system tray along the right side of the taskbar. If you are in an Office application and the clipboard is not displayed, double-clicking on this icon will open the task pane and display the clipboard items. If you are in a different application (not an Office product), double-clicking on this icon will display the Office application and activate the Office Clipboard within the task pane.

If you right-click on the clipboard icon located along the taskbar at the bottom of your screen, the following list of options will be displayed:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Show Office Clipboard" /></td>
<td>Show Office Clipboard</td>
</tr>
<tr>
<td><img src="image" alt="Clear All" /></td>
<td>Clear All</td>
</tr>
<tr>
<td><img src="image" alt="Stop Collecting" /></td>
<td>Stop Collecting</td>
</tr>
<tr>
<td><img src="image" alt="Options" /></td>
<td>Options</td>
</tr>
</tbody>
</table>

From this list, you can choose to display the Office Clipboard, clear all of the items currently being stored within the clipboard, or close the clipboard. The last item within this list allows you to specify the display options for the clipboard (which were discussed on the previous page).

If you do not specify otherwise, the collected items remain in the Office Clipboard until you close all Office applications.

**TIP:** To quickly display the Office Clipboard, you can do so by accessing the **Edit ➔ Office Clipboard...** menu or by pressing `CTRL+C` twice.
INSERTING A ROW/COLUMN

USAGE:

As you work with a worksheet, you may find it necessary to add a row or column. When inserting, Excel will move the contents of the currently selected row down or the current column to the right to make room for the new row/column.

To insert a column or row, follow these steps:

1. Select the row or column where the new one should appear.

   **NOTE:** To insert more than one row or column, you will need to click and drag across the row/column headers to select the number to be inserted.

2. While pointing to the selected column(s) or row(s), click the [RIGHT] mouse button once.

3. Select **Insert** from the pop-up menu that appears.
If you prefer accessing the menu:

**Insert**

**Rows** or **Columns**

You will be placed back in the worksheet and a new row or column (depending on what you had highlighted before entering the menu) will appear.

### DELETING A ROW/COLUMN

**USAGE:** You may also find yourself needing to delete a row or column. Your first step will be to select the column or row to be removed.

To remove a column or row, follow the steps outlined below:

1. The first step in deleting a row or column is to select it (using one of the methods described above).

2. Click the [RIGHT] mouse button once.

3. Choose delete from the pop-up menu that appears.
If you prefer accessing the menu:

**Edit**

**Delete**

You will be placed back in the worksheet and all of the rows or columns that you had highlighted before entering the menu will have been removed.

**NOTE:**

When deleting rows, the rows beneath the one(s) being deleted will be shifted up.

When deleting columns, the columns to the right of the one(s) being deleted will be shifted to the left.
PREVIEWING A WORKBOOK

USAGE: Previewing shows you the portion of the document that will be printed and how the worksheet will be positioned on the page(s) without actually printing a copy.

Select the Preview button.

MENU:
File
New...
Open...
Close
Save
Save As...
Save as Web Page
Save Workspace...
Search...
Web Page Preview
Page Setup...
Print Area
Print Preview
Print...
Send To
Properties
1 COMPANY.XLS
2 Supplier Form.xls
Exit

If you prefer accessing the menu:

File
Print Preview
The mouse pointer becomes a magnifying glass in the middle of the page while in the Preview mode. Click the button once to zoom in and a second time to zoom back out of the worksheet.

When zooming in and out with the mouse, be sure to place the mouse pointer on a portion of the actual worksheet. If you click on a white area, you will zoom into a blank section.

The following buttons appear across the top of the preview screen:

- **Next** Views the next page (if your workbook contains multiple pages).
- **Previous** Views the previous page (if your workbook contains multiple pages).
- **Zoom** Zooms in and out.
- **Print...** Opens the Print dialog box.
- **Setup...** Opens the Page Setup dialog box - where you can adjust such settings as paper size, margins, orientation, and headers/footers.
- **Margins** Display/hides the margins.
- **Page Break Preview** Displays/hides the page breaks.
- **Close** Closes the preview screen.
- **Help** Opens the help screen.
CHANGING THE PAGE SETUP

USAGE:

Before you print a worksheet, you may want to customize the file to change margins, adjust orientation, add headers/footers and modify other features.

You can access the Page Setup dialog box from the Print Preview screen by clicking on the Setup... button or within your worksheet by accessing the menu, as shown below:

**File**

**Page Setup...**

Whatever method used, the following box will be displayed:
Within the tab labeled **Page**, the following options are available:

**Orientation**
Use this section to change the paper orientation to **Landscape** or **Portrait**.

**Scaling**
This section allows you to enlarge or reduce the printout. Not all printers will be able to use this feature.

Use the **Adjust to:** option to reduce or enlarge the output from 10 to 400 percent of the original size.

Use the **Fit to:** option to specify exactly how many pages wide or tall you want the final printout to be.

**Paper size**
Provides various paper sizes to choose from. Available sizes will vary from printer to printer.

**Print quality**
Allows you to specify the resolution (dots per inch) for printing. The higher the number, the better the quality - but it also takes longer.

**First page number**
Leave this option at **Auto** to automatically start page numbering at the next sequential number or enter a number with which the first page should begin.
CUSTOMIZING MARGINS

To change the margins click on the **Margins** tab, as shown below:

- **Top/Bottom**: Use this section to change the top and bottom distance between the edge of the paper and the printout.

- **Left/Right**: Use this section to change the left and right distances between the edge of the paper and the printout.

- **Header/Footer**: Use this section to change the top and bottom distances between the edge of the paper and the header and/or footer. Make sure that this value is smaller than the **Top/Bottom** margins or the header will overlap the data.

- **Center on page**: This option is used to balance a printout by centering pages **Horizontally** (between the left & right margins) and/or **Vertically** (between the top and bottom margins).
PRINTING YOUR WORKSHEET

USAGE:

After you have saved your workbook, you will want to print it. If you do not specify otherwise, Excel assumes you want to print the entire worksheet. It is possible, though, to specify a print range.

Click on this tool to begin printing. If you select this tool, the worksheet will be printed - bypassing the print dialog box.

To display the “Print” dialog box, access the following menu:

**file**

**print...**

At the top of the dialog box, Excel displays the current printer. Click on the down arrow beside this box to choose another printer. From within this dialog box you can also select what you want to print (e.g., the current selection, active worksheet or entire workbook), how many copies are needed, whether multiple copies should be collated and which pages to print. In addition, you can instruct Excel to save the print job to a file to print at a later time.
This button allows you to further specify how the document will be printed.

When you click on the button, a second dialog box will be displayed, as shown below:

The tabs within this second dialog box will vary depending on the printer selected. The basic tabs are those discussed below:

- **Paper** Allows you to choose the paper size, orientation and paper tray source.
- **Graphics** Determines the printout quality.
- **Fonts** Specifies how TrueType fonts will be handled.
- **Device** Determines how printer memory is tracked by the print driver.

To close this second dialog box, choose **OK**.
Once you return to the main “Print” dialog box, click on OK to actually begin printing.

If you prefer to preview the print job before actually printing, click on the Preview button.

**NOTE:** To print only part of the worksheet, you would highlight the area you wanted to print and then select the printer menu. One of the options will be to print the **Selection**.

You can also highlight the block of cells you want to print and then access the **File → Print Area → Set Print Area** menu. Dashed lines will appear on your screen - indicating the print area. Once the print area is set, that becomes the permanent print block. To reset the print area, access the **File → Print Area → Clear Print Area** menu.

**TIP:** The shortcut key for printing is C+p. If you press this shortcut key combination, Excel will display the print dialog box.
CREATING A CHART

**USAGE:**

You can present worksheet data more effectively and make it easier to understand and analyze if you display it graphically, as illustrated below:

**Monthly Sales Report**

<table>
<thead>
<tr>
<th></th>
<th>March</th>
<th>April</th>
<th>May</th>
<th>3-Month Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widgets</td>
<td>546</td>
<td>522</td>
<td>653</td>
<td>1721</td>
</tr>
<tr>
<td>Sprockets</td>
<td>400</td>
<td>390</td>
<td>460</td>
<td>1250</td>
</tr>
<tr>
<td>Cogs</td>
<td>240</td>
<td>350</td>
<td>330</td>
<td>920</td>
</tr>
</tbody>
</table>

Excel comes with a **Chart Wizard** tool which steps you through the process of creating charts. These charts are automatically embedded within the worksheet but can be printed individually.

To embed a chart within the current worksheet, follow these steps:

1. Select the data to be charted.
2. Click on the **Chart** tool once (which is located on the standard tool bar).
After selecting the chart tool, follow the four steps in the resulting dialog box.

The Chart Wizard consists of four steps necessary to create a chart. Each step includes buttons used to move through the process. For example, the **Back** button allows you to move back to the previous screen to make a correction/change. The **Next** button moves to the next step. You will notice that some steps contain multiple tabs. Click on **Finish** only when everything is complete.

**Step 1** contains two tabs. The first one (labeled **Standard Types**) defines the type of chart desired. Select the **Chart Type** (from the left side) and then the **Sub-type** (from the right side).

![Chart Wizard Step 1](chart_wizard_step_1.png)

Notice there is a button in the bottom right-hand corner of this box which allows you to view a sample chart. Hold the button labeled **Press and Hold to View Sample** and a sample chart will replace the “Chart sub-type” section.
The second tab (labeled **Custom Types**) allows you to choose from a list of more custom chart types.

<table>
<thead>
<tr>
<th>Standard Types</th>
<th>Custom Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart type:</td>
<td>Sample:</td>
</tr>
<tr>
<td>Area Blocks</td>
<td><img src="image" alt="Pie chart" /></td>
</tr>
<tr>
<td>B&amp;W Area</td>
<td>4th qtr 26%</td>
</tr>
<tr>
<td>B&amp;W Column</td>
<td>1st qtr 29%</td>
</tr>
<tr>
<td>B&amp;W Line - Timescale</td>
<td>3rd qtr 24%</td>
</tr>
<tr>
<td>B&amp;W Pie</td>
<td>2nd qtr 21%</td>
</tr>
<tr>
<td>Blue Pie</td>
<td></td>
</tr>
<tr>
<td>Colored Lines</td>
<td></td>
</tr>
<tr>
<td>Column - Area</td>
<td></td>
</tr>
<tr>
<td>Columns with Depth</td>
<td></td>
</tr>
<tr>
<td>Cones</td>
<td></td>
</tr>
<tr>
<td>Floating Bars</td>
<td></td>
</tr>
</tbody>
</table>

Select from
- [ ] User-defined
- [ ] Built-in

Pie chart in shades of gray.

Notice there are two radio buttons located along the bottom left of this dialog box. You can select custom charts that are either **Built-in** or **User-defined** (those that you create and then save to use later with future charts).

Select the type of chart desired from the list provided.

**NOTE:** Creating custom user-defined charts is discussed in a future class.

Click on [Next >] to move to the next step.
Step 2 contains two tabs. The first one (labeled Data Range) allows you to specify the range to plot.

Enter the range of cells you want to plot. If you had selected a range of cells before clicking on the chart tool, they will automatically be placed in the Data range box.

Notice you can choose to plot the selected data by Rows or Columns. Click on the appropriate radio button. If you are unsure of which setting to choose, watch the sample change as you select each button. When you see the correct chart layout, you know you have selected the right choice.

If you click on the button, the box will be temporarily set aside and you will be taken back to the worksheet where you can select the range used for the chart.

Once the range has been selected, re-activate the chart wizard by clicking on (located in the right corner of the Chart Source Data title bar).
The second tab (labeled **Series**) is used to name and define each value series being plotted and labels for the x-axis.

**Name**
Use this box to enter a name for each series.

**Value**
Use this box to enter the cells being plotted.

**Category labels**
Select cells containing labels for the X axis.

When you enter the information in the boxes provided, the sample chart will reflect the new data. Each series (as created) should be **added** to the left side of the box. To **remove** an existing series, select the series to remove and click on **Remove**.

Click on **Add** to temporarily set aside the box and take you back to the worksheet where you can select the names and values needed for the chart. When complete, re-activate the chart wizard by clicking on **Add**.

Click on **Next >** to move to the next step.
Step 3 contains six separate tabs. The first tab (labeled Titles) allows you to enter chart titles. Click in the appropriate box and enter the text to be placed on each side of the chart. Notice that the sample on the right reflects changes as they are made.

<table>
<thead>
<tr>
<th>Titles</th>
<th>Axes</th>
<th>Gridlines</th>
<th>Legend</th>
<th>Data Labels</th>
<th>Data Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart title:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Category (X) axis:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Value (Y) axis:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Second category (X) axis:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Second value (Y) axis:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

THE AXES TAB

The second tab is used to display/hide the x and y axis for the chart. The sample on the right reflects changes as they are made.

<table>
<thead>
<tr>
<th>Titles</th>
<th>Axes</th>
<th>Gridlines</th>
<th>Legend</th>
<th>Data Labels</th>
<th>Data Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary axis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Category (X) axis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Automatic</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Category</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Time-scale</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>☑ Value (Y) axis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
THE GRIDLINES TAB

The third tab determines which gridlines (if any) will be included on the chart. Check the desired gridline box. Notice the chart reflects changes as you make them.

<table>
<thead>
<tr>
<th>Titles</th>
<th>Axes</th>
<th>Gridlines</th>
<th>Legend</th>
<th>Data Labels</th>
<th>Data Table</th>
</tr>
</thead>
</table>

- **Category (X) axis**
  - [ ] Major gridlines
  - [ ] Minor gridlines

- **Value (Y) axis**
  - [x] Major gridlines
  - [ ] Minor gridlines

---

THE LEGEND TAB

The fourth tab is used to add or remove legends. If you are plotting multiple series, a legend can help your audience to understand what the chart consists of. You can check the **Show legend** box and then choose where the legend should be placed. The sample chart reflects changes as they are made.

<table>
<thead>
<tr>
<th>Titles</th>
<th>Axes</th>
<th>Gridlines</th>
<th>Legend</th>
<th>Data Labels</th>
<th>Data Table</th>
</tr>
</thead>
</table>

- **Show legend**
- **Placement**
  - [ ] Bottom
  - [ ] Corner
  - [ ] Top
  - [ ] Right
  - [ ] Left
THE DATA LABELS TAB

The fifth tab specifies if and where data labels will be placed. Data labels are the actual values representing the bars/lines on the chart. Notice the sample reflects changes as they are made.

<table>
<thead>
<tr>
<th>Data Labels Tab Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label Contains:</td>
</tr>
<tr>
<td>- Series name</td>
</tr>
<tr>
<td>- Category name</td>
</tr>
<tr>
<td>- Value</td>
</tr>
<tr>
<td>- Percentage</td>
</tr>
<tr>
<td>- Bubble size</td>
</tr>
</tbody>
</table>

Separator: ▼

Legend key

THE DATA TABLE TAB

The final tab is used to add or remove a data table, which is a separate table containing the actual values stored in the cells being plotted. The chart reflects changes as you make them.

<table>
<thead>
<tr>
<th>Data Table Tab Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show data table</td>
</tr>
<tr>
<td>Show legend keys</td>
</tr>
</tbody>
</table>

Click on Next > to move to the next step.
Step 4 asks you to determine the placement of the chart. Select whether the chart should be inserted as a new sheet or as an object within the current worksheet. You can place the chart on the current worksheet and still print it separately. By default, Excel chooses to insert the chart as an object on the current sheet.

Once everything is complete, be sure to select Finish.

NOTE: For this manual, we will assume you chose to place the chart as an object in the current worksheet.

SELECTING CHART OBJECTS

As you move the mouse across the chart, Excel displays a tip box showing what part of the chart would be selected if you clicked the [LEFT] mouse button.

Before you can modify any chart object, you must select it - by clicking on it once. Handles (small black boxes) will surround the object - indicating you can now modify it. When you select the data series, the cells being plotted are also selected.

NOTE: To select an individual object (e.g., a single bar) of a series, click once on the object to select the series. Click a second time to select the individual object.

Be careful not to click twice too quickly as this is a shortcut for accessing the Format Data Series dialog box where you will be modifying the entire series.
SIZING THE CHART

1. Click on any of the outside borders surrounding the chart. Be sure you see the handles around the chart.

2. Place the tip of your mouse pointer on one of the handles. The pointer changes to a double-sided arrow.

3. Click and drag the mouse pointer to resize the chart. If you hold down the C key as you drag, the chart will be sized from the middle out. If you hold down the S key as you drag, the chart is sized proportionately.

MOVING THE CHART

It is also possible to move the chart to a new location within the worksheet. You move a chart by selecting it and then dragging it to its new location.

1. Select the outside border of the chart. Be sure you see the handles surrounding the chart.

2. Move the pointer to the background of the chart and then click and hold the [LEFT] mouse button down while dragging the chart to its new location.

As you begin dragging the chart, you will notice that the mouse pointer changes to a 4-way arrow.

PRINTING THE CHART

Once you add the chart to your worksheet, you can either print it out with the data or alone. If the chart is not selected, it will be printed as an object, along with your cell data.

To print the chart alone, click on it once (to select it) and then follow the normal printing steps.